
SYSTEMS ASSOCIATES, INC. 
Energy Management Systems 

 
User Guide

 



E N E R G Y  M A N A G E M E N T  S Y S T E M S  

CONTROLIQ User Guide 

© Systems Associates, Inc. 
500 Lehman Ave. 

Bowling Green, OH 43402 
Phone 800-433-9855 • Fax 419-352-3299 

 

i 



Information in this document is subject to change without notice.  Systems Associates, Inc. (SAI) may 
make changes for the improvement and efficiency of the operation of CONTROLIQ.  SAI makes the 
newest enhancements available to users with current and up-to-date service agreements.  This 
manual may not contain all updated features. 
 
The software described, furnished by SAI under license agreement, may be used only in accordance 
with the terms listed therein. 
 
© Copyright Systems Associates, Inc. 1986 - 2004 
 

Document Revision Date:  October 4, 2004

ii 



 

Table of Contents
Chapter 1 Introduction............................................................ 1-1 

About This User Guide................................................................. 1-1 
Who Should Read This User Guide? ........................................... 1-1 
How This User Guide Is Organized.............................................. 1-2 

Chapter 1: Introduction ..........................................................................1-2 
Chapter 2: Getting Started.....................................................................1-2 
Chapter 3: Program Layout ...................................................................1-2 
Chapter 4: System Setup.......................................................................1-2 
Chapter 5: Activities...............................................................................1-2 
Chapter 6: Tabular Points......................................................................1-2 
Chapter 7: Views....................................................................................1-2 
Chapter 8: Reports.................................................................................1-2 
Chapter 9: Schedules ............................................................................1-2 

Icons Used In This User Guide .................................................... 1-3 
Important Information.............................................................................1-3 
How-To ..................................................................................................1-3 
Warning..................................................................................................1-3 
Further Reading.....................................................................................1-3 

Where To Go From Here? ........................................................... 1-3 
Chapter 2 Getting Started ...................................................... 2-1 

The Big Picture ............................................................................ 2-1 
I/O Hardware..........................................................................................2-1 
CONTROLIQ Processor..........................................................................2-2 
CONTROLIQ Interface............................................................................2-2 

Features....................................................................................... 2-2 
System Setup.........................................................................................2-3 
User Privileges.......................................................................................2-3 
Managing Points ....................................................................................2-3 
Graphical Views.....................................................................................2-3 

iii 



 

Reporting ...............................................................................................2-3 
Scheduling .............................................................................................2-3 

Minimum Requirements ............................................................... 2-4 
Browser Settings....................................................................................2-4 

Installation.................................................................................... 2-4 
Application Support ...................................................................... 2-4 

User Guide.............................................................................................2-4 
On-Line Support.....................................................................................2-5 
Technical Support ..................................................................................2-5 

What is Next?............................................................................... 2-5 
Chapter 3 Program Layout ..................................................... 3-1 

Login Window .............................................................................. 3-1 
Desktop Shortcut ...................................................................................3-1 
Login Panel ............................................................................................3-1 

Main Application Portal (MAP) ..................................................... 3-2 
Application Header.................................................................................3-2 
System Status Tab.................................................................................3-3 
Main View Area......................................................................................3-4 
View Tab ................................................................................................3-4 
Control Panel .........................................................................................3-4 

Chapter 4 System Setup ........................................................ 4-1 
Points ........................................................................................... 4-1 

Analog Input...........................................................................................4-1 
Analog Output ........................................................................................4-1 
Digital Input ............................................................................................4-1 
Digital Output .........................................................................................4-1 
Meter......................................................................................................4-2 
ASIC1.....................................................................................................4-2 
Logic ......................................................................................................4-2 
Lookup ...................................................................................................4-2 
PID .........................................................................................................4-2 
Timer......................................................................................................4-2 

Users............................................................................................ 4-2 
Setup............................................................................................ 4-2 

Chapter 5 Activities ................................................................ 5-1 
Setpoints ...................................................................................... 5-1 
Overrides ..................................................................................... 5-1 
Alarms.......................................................................................... 5-2 
Setup............................................................................................ 5-2 

iv 



 

Up Next… .................................................................................... 5-2 
Chapter 6 Tabular Points ....................................................... 6-1 

Tabular Points Window ................................................................ 6-1 
Filter .......................................................................................................6-2 
Search....................................................................................................6-3 
Favorites ................................................................................................6-4 
Selection ................................................................................................6-6 
Edit .........................................................................................................6-6 
Columns.................................................................................................6-8 
Alarms....................................................................................................6-9 
Trend....................................................................................................6-10 
Row Count ...........................................................................................6-10 

Chapter 7 Views..................................................................... 7-1 
Main View Area............................................................................ 7-1 
Navigating Views ......................................................................... 7-2 

Control Panel .........................................................................................7-2 
View Tab ................................................................................................7-2 

Chapter 8 Reports .................................................................. 8-1 
Trend Reports .............................................................................. 8-1 

Live Trend ..............................................................................................8-1 
Historical Trends....................................................................................8-2 
Trend Setup ...........................................................................................8-2 
Trend Graph...........................................................................................8-5 
Tabular Data ..........................................................................................8-5 
Exporting and Printing Trends ...............................................................8-5 

Administrative Reports ................................................................. 8-6 
Activities.................................................................................................8-7 
Degree Day............................................................................................8-9 
Meters ..................................................................................................8-10 
Point Finder..........................................................................................8-11 
Point Snapshot.....................................................................................8-12 
Exporting and Printing Administrative Reports ....................................8-13 

Chapter 9 Schedules.............................................................. 9-1 
Standard Schedules..................................................................... 9-1 

Standard Schedules Window.................................................................9-1 
Exception Schedules.................................................................... 9-3 

Exception Schedules Window ...............................................................9-4 
Holiday Schedules ....................................................................... 9-6 

Holidays Window ...................................................................................9-6 

v 



 

Index ......................................................................................... 1 

vi 



 

Chapter 

1 
Chapter 1  Introduction 

This chapter provides an overview of  the CONTROLIQ User Guide.   

elcome to CONTROLIQ User Guide.  This guide gives users the information needed to take full 
advantage of the tools provided in CONTROLIQ, an intuitive and easy-to-use energy management 
application.  This chapter introduces the rest of the guide and serves as a jumping-off point to 
learning the ins and outs of the CONTROLIQ interface. 
 W

CONTROLIQ Energy Management Systems provide synergy in multi-faceted system architecture while 
permitting the freedom to utilize the best possible technology for the application regardless of brand.  
CONTROLIQ is a web-based solution that offers extreme flexibility, portability and scalability with 
customizable screens and user-access based control presentation.  CONTROLIQ offers the owner the 
technology necessary to address the complex nature of today’s HVAC and lighting systems, while presenting 
the user with simple navigation and a comfortable interface. 

About This User Guide 
This guide is a resource and manual for the operation of the CONTROLIQ interface.  Users can review the 
various functions and features of the application as well as its proper usage.  It is not the intent of this guide to 
be read from beginning to end, but rather is designed as a targeted reference tool.  The Table of Contents and 
Index provide quick and easy access to information that supplies direct, systematic instructions.  However, 
many chapters in this guide do build upon one another.  In those instances, references provided allow users to 
study the relevant information at their convenience. 

Who Should Read This User Guide? 
The CONTROLIQ User Guide is for all users of the application.  Because the interface provides user-specific 
access to the application, not all areas of this guide will hold relevance for every user.  For this reason, the 
guide’s organization centers on the functional layout of the interface.  System Administrators will find 
information regarding the setup and maintenance of the application while typical users will be able to access 
how-to information on common tasks.  Users should review this introductory chapter to determine which 
chapters hold the most pertinent information. 
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How This User Guide Is Organized 
This section provides a brief overview of the organizational structure of this guide. 

Chapter 1: Introduction 
This introduction provides users with a jumping-off point for learning the CONTROLIQ interface.  Chapter 
organization as well as commonly used icons gives users the tools needed to access information contained 
within to maximum effect. 

Chapter 2: Getting Started 
Chapter 2 offers a general overview to CONTROLIQ by examining interrelations between components, 
hardware controllers and programming logic of the Energy Management System.  This chapter paints the big 
picture of how to utilize CONTROLIQ by presenting features, minimum platform requirements, installation 
and configuration as well as outlining the various levels of program support. 

Chapter 3: Program Layout 
Chapter 3 tours the application interface supplying users with a map for navigation and utilization.  This chapter 
instructs users on the basics of interacting with the application and provides subsequent chapters for reviewing 
details on specific topics. 

Chapter 4: System Setup 
Chapter 4 assists the System Administrator responsible for implementing and maintaining their Energy 
Management Systems.  It allows System Administrators to define their Energy Management System as well as 
add, maintain and remove User access rights. 

Chapter 5: Activities 
Chapter 5 delves into working with Setpoints, Overrides and Alarms. 

Chapter 6: Tabular Points 
Chapter 6 covers the various ways of displaying Tabular Points within the CONTROLIQ application, using 
predefined filters, such as Groups or Setpoints, as well as a means of creating custom, user specific views 
known as Favorites. 

Chapter 7: Views 
Chapter 7 explores the many graphical views provided by CONTROLIQ.  These views can be system default or 
custom created for the application. 

Chapter 8: Reports 
Chapter 8 presents the available reports within CONTROLIQ.  Reports come in three categories – Historical, 
Live Trend and Administrative – and are available for export in several formats. 

Chapter 9: Schedules 
Chapter 9 outlines working with schedules.  Schedules grant a high level of control and automation over the 
entire Energy Management System.  Schedules can be of the Standard, Exception or Holiday variety. 

 1-2 



I N T R O D U C T I O N  C H A P T E R  1   
 

Icons Used In This User Guide 
The icons listed below and used throughout this guide alert the reader to important notes.  The meaning of 
each icon is presented here for easy identification. 

Important Information 

This icon marks important text related to the current topic.  User should pay 
close attention to these sections. 

How-To 
This icon signifies a systematic walkthrough of the steps necessary to complete a specific 
task. 

 

Warning 

Information presented with this icon deals with matters that affect 
the operation of CONTROLIQ and the entire Energy Management 
System. 

 

Furt
This
the 

 

her Reading 
 icon signifies additional information regarding a specific topic that, while not critical to 

operation of CONTROLIQ, may be helpful. 

0
	
Where To Go From Here? 
This introductory chapter gives readers a starting point in their journey toward mastering CONTROLIQ.  Most 
users can now proceed to the chapter covering the specific topic of their research.  Systems Administrators may 
be more interested in studying the big picture presented in Chapter 2 Getting Started before proceeding to 
the setup and maintenance of the system and its users in Chapter 4 System Setup.  Users new to 
CONTROLIQ should first familiarize themselves with the program interface in Chapter 3 Program Layout 
before proceeding on to other chapters.  
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Chapter 2  Getting Started 

This chapter introduces users to the basic form, functions and features of  CONTROLIQ. 

his chapter will give users an overview of the structure of CONTROLIQ.  Beginning with the big 
picture of CONTROLIQ’s role in the complete Energy Management System, users will explore 
application features, minimum software requirements, installation, system setup, user privileges and 
program support.   

T 
The Big Picture 
CONTROLIQ is only one part of a larger Energy Management System.  The entire system encompasses a 
variety of software and hardware elements that may expand beyond a facility’s boundaries.  Each element plays 
a specific role in the larger process of energy management.  These elements fall into three categories: 
Input/Output (I/O) Hardware, CONTROLIQ Processor and CONTROLIQ Interface.  

I/O Hardware 
I/O Hardware incorporates various Controllers and numerous hardware Components.  I/O Hardware may be 
pre-existing or part of a new installation.  Installed at various locations throughout a facility, Controllers and 
Components are often associated with specific locations, such as a meeting room or lobby area. 

Controllers contain the pre-set rules that read information from and/or control one or more Components.  
Controllers come in many brands.  Some of the more common follow: 

• ABB 

• ASIC/1 & ASIC/2 

• MODBUS 

• Opto-22 

• Photon Lighting Boards 

• Scientific Controls (Scientific Atlanta) 

2-1 



G E T T I N G  S T A R T E D  C H A P T E R  2   
 

Components are individual devices that make up the majority of an Energy Management System.  Each 
Component has a task linked to a specific Controller that determines its actions.  Common Components 
include: 

• Air Flow Monitor 

• Damper Actuator 

• Low Limit Switch 

• Relay 

• Temperature Sensor 

• Valve Actuator 

• Variable Frequency Drive 

• VAV 

The installation, setup and maintenance of Controllers, and their Components, is beyond the scope of this 
guide.  Please contact your Controller provider for more information. 

CONTROLIQ Processor 
The CONTROLIQ Processor contains two elements:  a data storage system, or Database, and a software central 
processor, or ‘brain’, also known as CIQProc.  The Database contains all the records and logs that represent 
data from Components and Controllers in addition to many other elements.  CIQProc is a software application 
that processes all the information in the Database and interacts with the numerous Controllers to ensure 
smooth operation of the entire Energy Management System.  CIQProc continuously communicates with 
Database and Controllers. 

CIQProc is proprietary software developed by SAI.  CIQProc is a standalone application that runs on a server 
located at the facility to allow communication with each of the Controllers and Components.  A separate 
manual details CIQProc installation, setup and maintenance.   

CONTROLIQ Interface 
The CONTROLIQ Interface, simply called CONTROLIQ, is a browser-based application that allows users to 
interact with CIQProc and therefore relay information to and from the Database, Controllers and Components.  
CONTROLIQ is an intuitive and easy-to-use application, acting as the main portal through which users may 
change Setpoints, acknowledge Alarms and perform many other activities.  CONTROLIQ displays in a web 
browser, like Microsoft Internet Explorer®. 

Features 
The following topics introduce users to the basic features of CONTROLIQ. 
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System Setup 
SAI personnel manage the initial setup and deployment of CONTROLIQ and its subordinate systems at the 
time of installation.  System Administrators use CONTROLIQ to add, delete and maintain EMS Points and 
Users.  For more information, see Chapter 4 System Setup. 

User Privileges 
CONTROLIQ allows System Administrators to grant varying levels of access to each User.  The level of access 
determines functional features based on User login.  This security feature prevents users from accidentally 
altering settings in areas beyond their responsibility.  For this reason, the CONTROLIQ User Guide focuses on 
functional operations.  It allows users to locate the information most relevant to their daily duties, regardless of 
access level.   

Users should be aware that information presented within this guide might be 
on topics beyond the scope of their access level.  For more information, see 
Chapter 4 System Setup. 

 

Managing Points 
CONTROLIQ lets users maintain Setpoints, acknowledge Alarms and apply Overrides for any Point in the 
system.  Points viewed in tabular listings are easily searchable and filterable.  Custom filters, called Favorites, 
give users instant access to needed information.  For more information, see Chapter 5 Activities and Chapter 
6 Tabular Points. 

Graphical Views 
CONTROLIQ presents real-time data superimposed on representational images.  This format allows images to 
display the relevant data from Components of a device, such as AHU, chiller, boiler or tower.  CONTROLIQ is 
also capable of displaying facility floor plans with live temperature readings.  CONTROLIQ includes several 
default graphical displays in addition to custom images designed by SAI.  For more information, see Chapter 7 
Graphics. 

Reporting 
Data collected from Components is stored in the Database.  Database Historical information displays in line 
graphs for review.  In addition, CONTROLIQ presents real-time data in Live Trend graphs.  System 
Administrators have custom reports on system usage and trends.  Users can export all reports in several 
formats.  For more information, see Chapter 8 Reports. 

Scheduling 
Scheduling grants control over turning subsystems on or off automatically.  Scheduling is at the heart of 
building automation.  Users create and maintain Standard, Exception and Holiday Schedules.  For more 
information, see Chapter 9 Schedules. 
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Minimum Requirements 
The following are the minimum requirements for running CONTROLIQ on a standard Personal Computer 
(PC): 

• Internet Explorer 6 Service Pack 1 

• VGA monitor capable of displaying 1024 X 768 resolution 

• Standard keyboard and mouse 

• Speakers capable of playing audio output 

• High-speed internet or local intranet connection 

Browser Settings 

Disable internet pop-up blockers on PCs planning to run CONTROLIQ.  
CONTROLIQ application windows may fail to load properly if pop-up blockers 
are not disabled.  Also, always install the latest security releases for Internet 
Explorer.  Further, if internet security settings are set to High, CONTROLIQ 
application windows may fail to load properly. 

0
Installation 
As a web-based application, there is no installation required on a standard PC other than the elements listed 
under Minimum Requirements.  Typically, SAI personnel manage the initial setup and deployment of the web 
server responsible for delivering CONTROLIQ.  SAI provides a URL or IP address that launches the 
CONTROLIQ application.  Because of this, there is little or no installation involved before CONTROLIQ can 
run on a PC. 

Application Support 
CONTROLIQ has several avenues for application support. 

User Guide 
This User Guide is the best place to start when looking for information regarding CONTROLIQ.  The Table of 
Contents and Index allow for quick and easy navigation.  The guide presents subject matter in clear and concise 
language addressing all the features of this application.  Upon installation of the complete CONTROLIQ 
Energy Management System, SAI provides a digital copy of this guide.  SAI grants permission to print this 
guide for personal reference.  As SAI makes product updates available, an updated version of this document 
will reflect those changes.  The Document Revision Date is located on page ii of this guide.  Users can find the 
most up-to-date version of this document at www.controliq.com. 

 2-4 

http://www.controliq.com/


G E T T I N G  S T A R T E D  C H A P T E R  2   
 

On-Line Support 
CONTROLIQ contains built in Help features accessible from the main navigation page.  This Help feature 
provides quick access to key information without the need to exit the application.  Users can also find more 
information at the CONTROLIQ website: www.controliq.com. 

Technical Support 
Telephone technical support and on-site visits require active service agreements.  To check the current state of a 
service agreement, please contact SAI at 800-433-9855. 

What is Next? 
This chapter provided the big picture regarding CONTROLIQ.  Most users can now proceed to the chapter 
covering the specific topic of their research.  System Administrators may proceed to the setup and maintenance 
of the system and its users in Chapter 4 System Setup.  Users new to CONTROLIQ should first familiarize 
themselves with the program interface in Chapter 3 Program Layout before proceeding on to other chapters. 
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Chapter 3  Program Layout 

This chapter gives users a tour of  the CONTROLIQ Login Window and Main 
Application Panel. 

he CONTROLIQ interface is an easy to navigate tool for accessing information regarding the Energy 
Management System (EMS).  All areas are accessible from a single Control Panel located on the Main 
Application Portal (MAP).  The MAP provides a centralized graphical display of the EMS status.  
Explore each of the elements located on the MAP in this chapter following a summary of the login 

process for CONTROLIQ. 

T 
Login Window 
CONTROLIQ enforces security through the login process.  Each user must first type a unique user name and 
password in the Login panel before CONTROLIQ grants access.  This process ensures that users may only 
access appropriate functions within the application.  CONTROLIQ tracks activities performed by users in the 
Database, allowing System Administrators to generate reports for productivity and accountability purposes. 

Launching the Login Window requires the URL or IP Address of the web server delivering CONTROLIQ.  
This address is determined during installation of the EMS and provided by SAI.  The typical method of 
accessing the Login Window requires users to type the designated address in the Address Bar of Internet 
Explorer. 

Desk
Use
othe
loca
CON	

top Shortcut 
rs wishing to use a Desktop Shortcut to launch CONTROLIQ, in a manner similar to 
r applications, can do so as well.  To create the Shortcut, drag the web page symbol, 
ted at the left end of the Internet Explorer Address Bar, to the PC’s Desktop.  Launch 
TROLIQ by simply double-clicking the new Shortcut. 

Login Panel 
The Login Panel, the left side of the Login window, contains the login fields and system status display.  The first 
two elements in the Login Panel are the User Name and Password fields.  Users login by typing the appropriate 
information into each field and then clicking the Log In button or pressing the Enter key on their keyboard.  
CONTROLIQ does not display the password when typing, for security reasons.  Below the Log In button are 
four bars displaying specific status information.   
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The first status bar displays whether or not CIQProc is properly running and alerts users if there is a problem 
with CIQProc or its server.  A green status bar with a checkmark indicates CIQProc is running properly while a 
red bar with a flashing caution symbol indicates it is down.  If CIQProc is not functioning, an audible alarm will 
also sound.  CIQProc is required to be running properly for CONTROLIQ to be fully functional.  A separate 
manual details the functions of CIQProc.  For more information on CIQProc’s role in the EMS, see Chapter 2 
Getting Started. 

The second bar displays Alarm Status.  The Alarm Status indicates if any EMS Points are in Alarm and whether 
or not any are acknowledged.  A green status bar with a checkmark indicates no Points in Alarm.  A red status 
bar with a flashing caution symbol indicates there are one or more Points in Alarm.  If any Points are in Alarm, 
an audible alarm will also sound.  Finally, an orange status bar with caution symbol indicates that all Points in 
Alarm have been acknowledged.  Only users with proper access rights may log in and acknowledge Alarms. 

The third status bar displays the system time of CIQProc in 24-hour formatting.  If CIQProc is not 
functioning, this status bar instead displays the time CIQProc became unavailable.  The last status bar displays 
the information from the main EMS Point.  By default, this point is Outside Air Temperature, which 
determines the behavior of most other Points. 

Main Application Portal (MAP) 
The Main Application Portal (MAP) comprises the main viewing area of CONTROLIQ.  From this portal, users 
may access all areas of the application.  Each of the following sections will introduce users to a specific feature 
of this interface.  Functions unique to this interface follow below while features explored in their own chapters 
will reference the appropriate chapter number. 

Application Header 
The Application Header is located at the top of the MAP and contains several important links in addition to the 
property name.  The first link is located at the left end of the Header and displays the logged in User Name.  
Clicking the User Name displays the Preferences window.  This window provides a means to change the 
current user’s Password or Default View. 

C H A N G E  C U R R E N T  U S E R ’ S  P A S S W O R D  

1. Click the underlined user name (left side of Application Header) 

2. The Preferences window opens 

3. Type the current password in the Current Password field of the Preferences 
window 

4. Type the new password in the  New Password field 

5. Re-type the new password (same as #4 above) in the Confirm Password field 

6. Click the OK button 
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C H A N G E  C U R R E N T  U S E R ’ S  D E F A U L T  V I E W  

1. Click the underlined user name (left side of Application Header) 

2. The Preferences window opens 

3. Click the dropdown arrow to open the New Default View list in the 
Preferences window 

4. Click on the item to become the New Default View 

5. Click the OK button 

The Property Name follows the current User Name link.  To the right of the Property name is the Help link.  
Click this link to display the on-line Help Menu.  The last link to the right is the Log Out link.  Click this link to 
log out of the application and display the Login Window. 

System Status Tab 
The System Status Tab is located below the Application Header, near the top of the MAP.  This Tab displays 
various colors that indicate the status of Points and CIQProc.  A green Tab indicates all Points are normal and 
CIQProc is running properly.  A red Tab indicates one or more points are in Alarm with the actual number of 
Points in Alarm displayed above the Tab.  A red Tab with the words SYSTEM IS DOWN indicates CIQProc 
is not functioning properly.  An audible alarm sounds whenever the System Status Tab is red.  An orange Tab 
indicates all Alarm Points are acknowledged with the actual number of acknowledged Alarms displayed above 
the Tab. 

Users can manage Points in Alarm with the System Status Tab. 

D I S P L A Y / H I D E  A L A R M  P O I N T S  

1. Click the System Status Tab when red or orange to display Alarm points 

2. Click the System Status Tab again to hide Alarm points 

For more information on acknowledging Alarms, see Chapter 5 Activities. 

 

 

S H O W  A L A R M  D A T A  

1. Right-click the System Status Tab 

2. Click Show Alarm Data on the pop-up menu 

For more information on working with Tabular Points, see Chapter 6 Data. 
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S I L E N C E  A U D I B L E  A L A R M  

1. Right-click the System Status Tab 

2. Click Silence Alarm on the pop-up menu 

 

The audible Alarm will silence on the user’s PC for ten minutes after which it 
will begin again. 

 

 

Main View Area 
The Main View Area comprises the graphical display in the center of the MAP.  This area displays an image, 
such as an air handler, boiler, chiller, tower, etc, with live data for associated Points.  For example, an air handler 
could display the Outside Air Temperature, Return Air Temperature, Mixed Air Temperature and Discharge 
Air Temperature.  Users, with proper rights, access these Points directly from the image.  For more 
information, see Chapter 7 Views. 

View Tab 
The View Tab is located on the bottom edge of the MAP.  The Tab displays the name of the current View.  
Use this menu to navigate between the available graphical Views displayed in the MAP.  For more information, 
see Chapter 7 Views. 

Control Panel 
The Control Panel, located on the left side of the MAP, is the main navigation tool for CONTROLIQ.  The 
Control Panel is context sensitive based on the logged in user’s rights.  It will only display those items a user 
may access.  For this reason, the Control Panel may look different depending on the user logged in.  In all, there 
are five areas in the Control Panel, each area containing links to different activities and reports.  While the list 
below contains all five areas, users should be aware they might not have access to some areas. 

• Activities – Management of EMS Points, contains the following links covered in Chapter 5 

o Setpoints 

o Overrides 

o Alarms 

o Setup 

• Tabular Points – Working with Tabular Points of CONTROLIQ, contains the following links 
covered in Chapter 6 
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o All (W/ Filters) 

o Groups 

o Favorites 

• Graphics – Allows navigation of Graphic View, contains the following link covered in Chapter 7 

o Views 

• Reports – Generating EMS and Administrative Reports, contains the following links covered in 
Chapter 8 

o Historical 

o Live Trend 

o Administrative 

• Schedules – Maintaining Building Automation Schedules, contains the following links covered in 
Chapter 9 

o Standard 

o Exception 

o Holiday 

N A V I G A T I N G  W I T H  T H E  C O N T R O L  P A N E L  

1. Click the Control Panel Tab 

2. Click the desired link to open that activity 

 

The Control Panel automatically closes after selecting the desired link.  To close 
the Control Panel without clicking a link, click the Control Panel Tab again or 
click anywhere outside the Control Panel. 
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Chapter 4  System Setup 
This chapter delves into the process for defining, modifying and maintaining the underlying 
EMS through CONTROLIQ. 

he CONTROLIQ Energy Management System (EMS) is defined by a collection of software and 
hardware elements and those users with access to those elements.  System Setup allows System 
Administrators the ability to define Points and Users for CONTROLIQ. T 

Points 
As discussed earlier, CONTROLIQ interacts with the hardware Components and Controllers to manage the 
system.  CONTROLIQ defines this collection of elements as a series of Points.  There are ten types of Points 
within CONTROLIQ.  There is currently no limit to the number of individual Points allowed within 
CONTROLIQ.  

The first five types of Points are always associated with a real-world Component. 

Analog Input 
An Analog Input (AI) is a measurement provided by a Component and read by CONTROLIQ.  Typical AIs 
measure temperature, static pressure or water level.  AIs are often useful in the programming of Logic and PID 
Points. 

Analog Output 
Analog Outputs (AO) represent the commands produced by CONTROLIQ for certain Components.  Damper 
and valve actuators as well as variable speed drives often contain AOs. 

Digital Input 
A Digital Input (DI) reads the state of a Component.  DIs possess one of two states: on or off.  CONTROLIQ 
read DIs from photocells, pumps and fans. 

Digital Output 
Digital Outputs (DO) represent the commands produced by CONTROLIQ to change the current state of a 
Component.  Lights, pumps and fans often contain DOs. 

4-1 



S Y S T E M  S E T U P  C H A P T E R  4   
 

Meter 
A Meter is a Point that counts the number of cycles of a specific DI.  It can count, for example, the number of 
pulses from an electric meter.  

The next five types of Points are specialized types of Points that may not relate to a real-world Component.  
These Points often represent control logic for determining Component and Controller behavior. 

ASIC1 
The ASIC1 Point communicates with the ASI Controller of the same name.   

Logic 
A Logic Point contains an equation of up to 20 variables.  Logic Points often determine the behavior of 
Components using AO or DO. 

Lookup 
A Lookup Point translates a numeric input into a text message.  In this way, an AI displays as SYSTEM 
NORMAL or other text message. 

PID 
A PID is a specialized form of Logic Point.  This type of Point often controls dampers and valves. 

Timer 
The Timer Point provides a delay between operations.  For example, use of a Timer delays the start of a fan to 
allow the dampers to open. 

Users 
The definition of a User, for the purposes of this Guide, is as an individual with the ability to log into 
CONTROLIQ.  Users gain specific access rights within CONTROLIQ to determine those elements they may 
utilize.  Each individual may receive different rights from those of other co-workers.  There is currently no limit 
to the number of Users defined in CONTROLIQ. 

Setup 
SAI personnel manage the initial setup and deployment of CONTROLIQ and its subordinate systems at the 
time of installation.  Future versions of CONTROLIQ will allow program administrators the ability to add, 
delete and maintain system points and users.  Please contact SAI Technical Support for more information on 
this subject. 
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Chapter 5  Activities 
This chapter investigates the Activities program group where users will most often interact 
with the underlying EMS. 

he Activities area of the Control Panel acts as a shortcut to some of the most commonly used features 
in CONTROLIQ.  Because most of the following functions are also accessible from the Tabular Points 
area of the Control Panel, this chapter will serve as an introduction to the topics of Setpoints, 
Overrides and Alarms.  The User Guide covers these three topics in full in Chapter 6 Tabular Points.  

System Setup is covered in Chapter 4 and is listed here as a reference point. 

T 
Setpoints 
Setpoints are one parameter of EMS Points.  Setpoints are the target value for a specific EMS Point and control 
the behavior of Components as part of the programming that manages the CONTROLIQ EMS.  Not all EMS 
Points have Setpoints.  Some Points, like Outside Air Temperature, have no Setpoints.   

The value of Setpoints depends on the type of EMS Point.  Setpoints are most often AO, except when used by 
Logic or PID Points in which case they are AI.  EMS Points have both Enabled and Disabled Setpoints.  In the 
case of a room temperature, for example, the Enable value is the temperature desired for an occupied room.  
The Disabled Value represents the target temperature for an unoccupied room. 

Setpoints are permanent settings stored in the Database.  Changes made to Setpoints are still part of the 
programming controlling the CONTROLIQ EMS and remain in effect until changed. 

The Setpoints link in the Activities area of the Control Panel opens the CONTROLIQ Tabular Points window 
and filters the list to display only those EMS Points that have Setpoints.  Users must have proper access rights 
to edit Setpoints. 

Overrides 
Overrides are another way of changing EMS Point parameters.  The difference between Setpoints and 
Overrides is one of time and programming.  Overrides are most often a temporary change to a parameter or 
state of a Point.  This allows Users to turn on a fan for a crowded room for the duration of a meeting.  Once 

5-1 



A C T I V I T I E S  C H A P T E R  5   
 

the duration passes, the state returns to its previous setting automatically.  Overriding is also often helpful when 
testing dependant EMS Points for properly applied programming.  Overrides can be set never to expire, i.e. 
Override duration is forever.  This setting should be used with caution as dependent sub-systems may not 
function properly, possibly causing damage to Components. 

Overrides do not adhere to pre-programmed conditions.  Once overridden, a Point remains in that state until 
the duration has passed or the Override removed, regardless of any preplanned scheduling or programming. 

The Overrides link in the Activities area of the Control Panel opens the CONTROLIQ Tabular Points window 
and filters the list to display only those EMS Points in Override.  Users must have proper access rights to apply 
Overrides. 

Alarms 
Alarms exist in CONTROLIQ to notify Users when the current state of a Point is outside normal operating 
parameters.  These parameters are device specific and set up during EMS installation.  Users may modify these 
Alarm settings using CONTROLIQ System Setup.  CONTROLIQ logs in the Database when the Alarm begins, 
is acknowledged and ends.  Acknowledging an Alarm is the User action of accepting CONTROLIQ’s Alarm 
notification. 

In CONTROLIQ, an Alarm appears in several places and accompanies an audible siren.  The Alarm Status is 
visible in both the Login window and the System Status Tab of the MAP.  If the Status appears in green all is 
normal.  If the Status appears in red, then one or more points is in Alarm.  Finally, if the Status appears in 
orange, all Alarms are acknowledged. 

 The Alarms link in the Activities area of the Control Panel opens the CONTROLIQ Tabular Points window 
and filters the list to display only those EMS Points in Alarm.  Users must have proper access rights to 
acknowledge Alarms. 

Setup 
SAI personnel manage the initial setup and deployment of CONTROLIQ and its subordinate systems at the 
time of installation.  For more information, see Chapter 4 System Setup. 

Up Next… 
This chapter introduced the concepts of Setpoints, Overrides and Alarms.  Proceed on to the next chapter to 
get systematic instruction on working with these features as well as other Tabular Points. 
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Chapter 6  Tabular Points 

This chapter explores how CONTROLIQ displays Tabular Points from the underlying 
EMS. 

s mentioned in Chapter 4 System Setup, real-world Components and Controllers are represented in 
CONTROLIQ as Points.  Each EMS Point contains various parameters that control Component 
behavior.  The current state of the Point is available to Users from the Tabular Points links on the 
Control Panel.  Each of these three links, as well as three more links in the Activities area of the 

Control Panel, provides access to Points information.  Each is a different way of viewing the same information.  
Some links look at a small subset of Points, while others display a custom list of Points.  Each of the links is 
discussed briefly before delving into the workings of the Tabular Points window used to display CONTROLIQ 
Points. 

A 

• All Data – This link opens the Tabular Points window displaying all active EMS Points within 
CONTROLIQ. 

• Groups – Groups categorize and organize EMS Points into logical and meaningful collections.  
Groups are user defined and specific to individual installations of CONTROLIQ.  Placing the 
mouse over the Groups link in the Control Panel displays a list of available Groups.  Clicking one 
of these menu items will display the Tabular Points window with a Points list filtered to show the 
selected Group. 

• Favorites – Favorites are User defined filters for viewing EMS Points.  CONTROLIQ has three 
default favorites: Alarms, Override, Setpoints.  Chapter 5 Activities discusses these default 
Favorites.  Users can create custom filters and save each for repeated viewing.  Favorites store the 
filters as well as the displayed columns.  Placing the mouse over the Favorites link in the Control 
Panel displays a list of User specific Favorites.  Clicking one of these menu items will display the 
Tabular Points window with a Points list filtered for the preset view. 

Tabular Points Window 
By default, the Tabular Points window displays the Name, Group, Value and Status columns.  Selection and 
Edit columns are visible to Users with sufficient access rights.  The following sections describe each column 
and all of the window elements. 
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Filter 
The Filter control, upper left corner of the Tabular Points window, consists of two linked dropdown lists.  
First, select the left dropdown, which contains the master filter list.  Some items on this list are sensitive to 
security access and may not be visible to all Users.  Once an item is selected from this list the second dropdown 
list, right of the equal sign (=), populates with related choices.  Selecting an item from the second dropdown list 
applies the Filter to the Tabular Points list.  Only active Points matching the Filter display below these controls. 

• All – Displays all active Points within CONTROLIQ.  Once selected, the second dropdown list 
contains the following options: 

o All –  Displays all active Points within CONTROLIQ 

o Setpoints – Displays only active Points with Setpoints 

o Non-setpoints – Displays only active Points without Setpoints 

• Group – Allows filtering active Points list by pre-defined Groups.  Selecting Groups populates the 
second dropdown list with available Groups.  Selecting an item from the second dropdown list will 
filter the Points list to only active Points matching the selected Group.  Groups are property 
specific and determined at the time of installation or with System Setup.  For more information 
regarding defining Groups, refer to Chapter 4 System Setup. 

• Status – Allows filtering active Points list by Alarm status.  Once selected, the second dropdown 
list contains the following options: 

o All – Displays only active Points in Alarm or Acknowledged status 

o Alarm – Displays only active Points in Alarm status 

o Acknowledged – Displays only active Points in Acknowledged status 

• Override – Allows filtering active Points list by Override status.  Once selected, the second 
dropdown list contains the following options: 

o All – Displays all active Points within CONTROLIQ 

o True – Displays only active Points that have been placed in Override 

o False – Displays only active Points that have not been placed in Override 

• Subsystem – Allows filtering active Points list by pre-defined Subsystems.  Selecting Subsystem 
populates the second dropdown list with available Subsystems.  Selecting an item from the second 
dropdown list will filter the Points list to only active Points matching the selected Subsystem.  
Subsystems are property specific and determined at the time of installation or with System Setup.  
For more information regarding defining Subsystems, refer to Chapter 4 System Setup. 
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• Address – Allows filtering active Points list by pre-defined Addresses.  Selecting Address populates 
the second dropdown list with available Addresses.  Selecting an item from the second dropdown 
list will filter the Points list to only the active Point matching the selected Address.  Addresses are 
property specific and determined at the time of installation or with System Setup.  For more 
information regarding defining Subsystems, refer to Chapter 4 System Setup. 

• Point Type– Allows filtering active Points list by Point Type.  Selecting Point Type populates the 
second dropdown list with available Point Types. Selecting an item from the second dropdown list 
will filter the Points list to only active Points matching the selected Point Type.  Point Types used 
are property specific and determined at the time of installation or with System Setup.  For more 
information regarding defining Point Types, refer to Chapter 4 System Setup. 

A P P L Y  F I L T E R  T O  T A B U L A R  P O I N T S  L I S T  

1. Click on the first dropdown Filter (left of equal sign (=) ) to display choices 

2. Click on the desired selection 

3. Click on the second dropdown Filter (right of equal sign (=) ) to display choices 

4. Click on the desired selection 

5. The Tabular Points list is now filtered for the desired selection 

 

R E M O V E  F I L T E R  F R O M  T A B U L A R  P O I N T S  L I S T  

1. Click on the first dropdown Filter (left of equal sign (=) ) to display choices 

2. Click on All 

3. The Tabular Points list is no longer filtered for the previous selection 

 

Search 
A Search field and Search button, left of the Filter controls, comprise CONTROLIQ’s Search control.  The 
Search button easily allows Users to display specific Points in the Tabular Points list.  CONTROLIQ compares 
text entered into the Search field with the Alias and Name of all active Points.  For example, entering the text 
ahu would return the Points containing the letters ‘ahu’ in either the Name or Alias, regardless of capitalization. 

A P P L Y  S E A R C H  F I L T E R  T O  T A B U L A R  P O I N T S  L I S T  

1. Click in the Search field (right of the Filter controls) 

2. Type the desired text 
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3. Click the Search button 

4. The Tabular Points list is now filtered for the desired selection 

Filters applied because of Search are in addition to any filters applied by the 
Filter controls.  Use the All Filter option to ensure accurate listing of text-
matched results.  Searches applied in addition to Filters are an excellent way of 
shortening the Tabular Points list to target specific Points. 

 

R E M O V E  S E A R C H  F I L T E R  F R O M  T A B U L A R  P O I N T S  L I S T  

1. Click in the Search field ( left of the Filter controls) 

2. Delete the text within Search field 

3. Click the Search button 

4. The Tabular Points list is no longer filtered for the previous selection 

Previously set Filters still apply to the Tabular Points list after removing a 
Search filter.  To ensure all filters are removed follow the How-to procedure 
Remove Filter from Tabular Points List. 

 

Favorites 
The Favorites dropdown list, near the upper right corner, left of the Manage Favorites button, provides a fast 
and simple way to customize the Tabular Points list.  Saved views appear on the dropdown list below three 
CONTROLIQ Favorites.  The first three items listed – Alarms, Overrides and Setpoints – are system defaults 
available to all Users with access to Tabular Points.  Items appearing below the separator line of the Favorites 
dropdown list are unique to the currently logged in User and available to no one else. 

A P P L Y  F A V O R I T E  V I E W  T O  T A B U L A R  P O I N T S  L I S T  

1. Click on the Favorites dropdown list (near the upper-right corner, left of the 
Manage Favorites button) 

2. Click on the desired selection 

3. The Tabular Points list is now filtered for the desired selection 
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R E M O V E  F A V O R I T E  V I E W  T O  T A B U L A R  P O I N T S  L I S T  

1. Click on the Favorites dropdown list (near the upper-right corner, left of the 
Manage Favorites button) 

2. Click on All 

3. The Tabular Points list is no longer filtered for the previous selection 

 

A D D  N E W  V I E W  T O  F A V O R I T E S  

1. Arrange the view to desired specifications by applying Filters, text Search, 
adding and sorting Columns 

2. Click the Manage Favorites button 

3. The Favorites Manager window opens 

4. Type a name for the view (as it will appear on Favorites dropdown list) in the blank text field of the 
Favorites Manager window 

5. Click the Add button 

6. The view is now saved as a Favorite 

 

D E L E T E  V I E W  F R O M  F A V O R I T E S  

1. Click the Manage Favorites button 

2. The Favorites Manager window opens 

3. Click on the Favorites dropdown list in the Manage Favorites window 

4. Click on the desired selection 

5. Click the Delete button 

6. The selected view is now deleted from Favorites 

 

The system Favorite Alarm, Override and Setpoints display the same data as 
the Activities links of the same name.  It is not possible to delete a system 
Favorite. 
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Selection 
The Selection column appears as the first column at the left of the Tabular Points list.  Each row in this column 
contains a checkbox.  Use this checkbox to specify selected Points.  For example, working with a Trend graph 
requires Users select one or more Points for the graph.  Users may select up to ten (10) Points at one time.  
This limit applies across multiple pages of the Tabular Points list.  Once ten Points have been selected, the 
remaining checkboxes become inactive. 

S E L E C T  A  P O I N T  I N  T H E  T A B U L A R  P O I N T S  L I S T  

1. Click in the empty checkbox in the Selection column of the desired Point, a 
check mark will appear 

2. Click in the empty checkbox of up to nine (9) more Points 

 

C L E A R  A  S E L E C T E D  P O I N T  I N  T H E  T A B U L A R  P O I N T S  L I S T  

1. Click the check mark in the Selection column of the desired Point, the check 
mark will clear 

2. Click the check mark of any remaining selected Points 

The current number of selected points appears above the Selection column. 

 

 

C L E A R  A L L  S E L E C T E D  P O I N T S  I N  T H E  T A B U L A R  P O I N T S  L I S T  

1. Click the Clear Selection button (lower left corner of Tabular Points list) 

2. All the selected Points are now cleared 

 

Edit 
The Edit column appears as the second column on the left of the Tabular Points list.  Each row in this column 
contains an icon of paper and pencil.  The Edit column only displays for those Users with sufficient access 
rights.  Clicking the Edit icon for a Point opens either the Setpoint Editor or the Set Override window, 
depending on the type of the Point. 
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E D I T  S E T P O I N T  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Edit icon in the Edit column of the desired Point 

2. The Setpoint Editor window opens 

3. Edit the Enabled Value as needed 

4. Edit the Disabled Value as needed 

5. Click the Apply button 

If Disabled Value is blank (no value), CONTROLIQ uses the Enabled Value 
at all times. 

 

 

S E T  A N A L O G  O V E R R I D E  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Edit icon in the Edit column of the desired Point 

2. The Set Override window opens 

3. Click the Override radio button 

4. Edit the Value as needed 

5. Enter the Duration or click the Forever checkbox (see related notes below) 

6. Click the Apply button 

 

S E T  D I G I T A L  O V E R R I D E  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Edit icon in the Edit column of the desired Point 

2. The Set Override window opens 

3. Click the Override radio button 

4. Click on the Value dropdown list 

5. Click on the desired state for the Point 

6. Enter the Duration or click the Forever checkbox (see related notes below) 
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7. Click the Apply button 

 

C L E A R  O V E R R I D E  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Edit icon in the Edit column of the desired Point 

2. The Set Override window opens 

3. Click the Auto radio button 

4. Click the Apply button 

There are several methods for editing the Duration of an Override.  The first 
method uses spin arrows, upward and downward pointing arrows to the right 
of the Duration field.  Each arrow increases (upward arrow) or decreases 
(downward arrow) the Duration value by 30 minutes.  The second method 
allows Users to enter the Duration in minutes, i.e., entering ‘120’ for two-hour 

Duration.  The final method involves entering the Duration in standard hours and minutes 
format, i.e., ‘1:25’ for one hour and 25 minutes.  Use of the spin arrows is also possible with the 
second and third methods, increasing or decreasing the entered Duration by 30 minutes. 

Use the Forever setting for Override duration with caution as 
dependent sub-systems may not function properly, possibly causing 
damage to Components. 

 

 

Columns 
EMS Point information displays within various columns of the Tabular Points list.  Each column contains one 
piece of data for each Point.  By default, the Tabular Points window only displays the Selection, Name, Group, 
Value and Status columns when first opened.  These default columns may never be hidden.  Alias, Subsystem, 
Point Type, Override, Address, Setpoint Value and Disabled Position columns are also available for display.  
Users with proper security gain access to the Edit column.  Aside from the Selection and Edit columns, each 
column can also be sorted in ascending order. 

S O R T  A  C O L U M N  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the underlined name in the Column header, i.e., click Value 

2. The Column is now sorted in ascending order 

 

0
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S H O W  H I D D E N  C O L U M N S  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Columns button (lower right corner of Tabular Points list) 

2. The Column View panel displays 

3. Click in the empty checkbox of the desired Column in the Column View panel, a 
check mark will appear 

4. The Column is now displayed in Tabular Points list 

5. Click any remaining empty checkboxes to display hidden Columns 

6. Click the Close button in Column View panel 

 

H I D E  C O L U M N S  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Columns button (lower right corner of Tabular Points list) 

2. The Column View panel displays 

3. Click the check mark of the desired Column in the Column View panel, the 
check mark will clear 

4. The Column is no longer displayed in Tabular Points list 

5. Click any remaining check marks to hide Columns 

6. Click the Close button in Column View panel 

 

Alarms 
CONTROLIQ provides a visual display of Points in Alarm.  These Points exhibit red labels if the Point is in 
Alarm and orange labels for acknowledged status.  The labels appear in the Value column of the Tabular Points 
list.  Users with sufficient access rights can acknowledge Points in Alarm from within the Tabular Points list. 

A C K N O W L E D G E  A L A R M  I N  T A B U L A R  P O I N T S  L I S T  

1. Click in the empty checkbox in the Selection column of the Point in Alarm (red 
labeled Value), a check mark will appear 

2. Click the Acknowledge button (lower left corner of Tabular Points list) 

3. The red label will change to orange once the window refreshes to show the Alarm as acknowledged 
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Trend 
Trends are a form of Report that graphs Point behavior over time.  Trends can be Live, updating at regular 
intervals, or Historical, displaying data collected over the past few days, weeks, months or even years.  Historical 
Trends can go back as far as historical data exists.  Users can graph up to ten (10) Points.  For more 
information on Trends, see Chapter 8 Reports. 

S E L E C T  P O I N T S  T O  T R E N D  I N  T A B U L A R  P O I N T S  L I S T  

1. Click in the empty checkbox in the Selection column of the desired Point, a 
check mark will appear 

2. Click in the empty checkbox of up to nine (9) more Points 

3. Click the Trend button (lower left corner of Tabular Points list) 

 

Row Count 
Users control how many rows of Points display in the Tabular Points list.  The Row Count dropdown list, 
lower right corner of the Tabular Points list, left of the Columns button, provides a range of choices for the 
number of displayed rows.  Users may move through the list by using the Page control, upper right corner of 
the Tabular Points list, below the Manage Favorites button. 

C H A N G E  N U M B E R  O F  R O W S  D I S P L A Y E D  I N  T A B U L A R  P O I N T S  L I S T  

1. Click the Row Count dropdown list (lower right corner of Tabular Points list) 

2. Click on the desired number of rows to display 

3. The Tabular Points list now displays the desired number of rows per page 

 

N A V I G A T E  T O  D I F F E R E N T  P A G E  O F  T A B U L A R  P O I N T S  L I S T  

1. Click the underlined number of the page desired, i.e., click 3 to go to page three 
(3) 

2. The desired page is now displayed 

If more than five (5) pages of Points exists, the Page control displays ‘…’ to 
signify the previous (left of page numbers) or next (right of page numbers) 
group of  five pages. 

 

 

 6-10



 

Chapter 

7 
Chapter 7  Views 

This chapter examines user interaction with graphical Views of  the CONTROLIQ 
MAP. 

he Main View Area of the CONTROLIQ Main Application Portal (MAP) is a highly customizable 
display.  The display presents representational images, such as air handlers, boilers and chillers, with 
real-time data from associated Points.  These Views also allow instant access to key information for 
Points within CONTROLIQ. 

T 
It is easy to navigate the customized Views using the Views link of the Control Panel or the View Tab of the 
MAP.  Views displayed depend on User access rights, so Users may not see the same Views. 

Main View Area 
The Main View Area comprises the graphical display in the center of the MAP.  The displayed images present 
live data for associated Points.  For example, an air handler could display the Outside Air Temperature, Return 
Air Temperature, Mixed Air Temperature and Discharge Air Temperature.  Users, with proper rights, access 
these Points directly from the image.   

Below is a list of images and commonly associated Points, followed by instructions for displaying Point 
information in Tabular Points.  This list is not comprehensive.  The Views presented are only some of those 
possible.  SAI provides custom views to suit a property’s needs.  Please contact SAI for more information 
regarding the development of custom views. 

• Air Handler – Outside air temperature, return air temperature, mixed air temperature, static air 
pressure, fan state, fan speed, discharge air temperature, damper state 

• Boiler – Boiler status, entering hot water temperature, leaving hot water temperature, outlet 
setpoint 

• Chiller – Chiller amps, entering condenser water temperature, leaving condenser water 
temperature, entering chilled water temperature, leaving chilled water temperature 
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• Cooling Tower – Inlet temperature, outlet temperature, outlet setpoint, variable frequency drive 
speed 

• Floor Plan – Room temperature 

D I S P L A Y  P O I N T  D A T A  

1. Right-click the Point Value 

2. Click Show in Tabular Points on the pop-up menu  

 

Navigating Views 
Two tools exist for navigating Views within CONTROLIQ.  The first, the Control Panel, is the default method 
for selecting and displaying a View.  The View Tab provides a similar interface while adding an easy method for 
cycling through Views in quick succession. 

Control Panel 
The Control Panel provides a pop-up list of Views for easy navigation.  This list, as well as the View Tab, are 
sensitive to the logged in User and only display appropriate choices. 

N A V I G A T I N G  W I T H  T H E  C O N T R O L  P A N E L  

1. Click the Control Panel Tab 

2. Place mouse over Views link to display available Views 

3. Click the name of the desired View to display 

 

View Tab 
The View Tab is located on the bottom edge of the MAP.  The Tab displays the name of the current View.  
Use this menu to navigate between the available graphical Views displayed in the MAP.  This list, as well as the 
Views area of the Control Panel, are sensitive to the logged in User and only display appropriate choices. 

C H A N G E  C U R R E N T  V I E W  

1. Click the center of the View Tab to open the list of available Views 

2. Click the name of the desired View to display 

 

The triangles on the left and right of the View Tab allow navigation through the available Views. 
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N A V I G A T E  A V A I L A B L E  V I E W S  

1. Click the left triangle on the View Tab to see the preceding View from the list 

2. Click the right triangle on the View Tab to see the following View from the list 
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Chapter 8  Reports 

This chapter surveys the many reporting options available within CONTROLIQ. 

ata collected by CONTROLIQ is stored in the Database.  Reports present this data in a variety of 
formats.  The most commonly used feature is Trend Reports.  Trends are line graphs that plot EMS 
Point information over time.  Other reports fall under the Administrative Reports heading.  Each 
Administrative Report has a specific scope.  This chapter explores both styles of reports in depth. 

Trend Reports 
Trend Reports display data collected from EMS Components as line graphs.  These graphs chart Point 
behavior over time.  Live Trends are charts displaying real-time data as it is collected.  Trends that display 
graphs of data collected during an earlier time are Historical Trends.  Up to ten (10) Points can be 
simultaneously graphed.  Both Live and Historical Trends are generated in the same manner using the Trend 
Setup panel of the Trend Graph window. 

Live Trend 
Live Trend graphs give Users the current picture of how their EMS Points are performing.  Data collected 
dynamically displays for the selected Points on a real-time basis.  The interval between data collection can be as 
short as one (1) second or as long as the User wishes. 

D 

G E N E R A T E  A  L I V E  T R E N D  G R A P H  

1. Click the Control Panel Tab 

2. Click on Live Trend in the Reports area of the Control Panel 

3. The Trend Graph window opens displaying the Trend Setup panel 

4. Select the Update Interval on the Trend Setup panel 

5. Select the interval period (Seconds, Minutes or Hours) from the dropdown list 

6. Enter the Point Aliases or Select Points to Trend 
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7. Click the OK button 

8. The Live Trend Graph displays 

 

Historical Trends 
Historical Trend graphs are identical to Live Trends except they represent static data that can be from any 
period.  Historical Trend reports allow Users to select a period from any point in time for which they have data.  
Historical Trends can cover a day, week, month or longer period.  Users are still limited to plotting ten (10) 
simultaneous Points. 

G E N E R A T E  A  H I S T O R I C A L  T R E N D  G R A P H  

1. Click the Control Panel Tab 

2. Click on Historical in the Reports area of the Control Panel 

3. The Trend Graph window opens displaying the Trend Setup panel 

4. Select the Starting Date and Time on the Trend Setup panel 

5. Select the Ending Date and Time 

6. Enter the Point Aliases or Select Points to Trend 

7. Click the OK button 

8. The Historical Trend Graph displays 

Historical Trend periods greater than three (3) months will take 
longer to generate and use more server resources. 

 

 
0
 

Trend Setup 
The Trend Setup panel, located on the Trend Graph window, allows Users to generate both Live and Historical 
Trend Reports.  This panel first displays when one of these report styles is selected.  It can also be displayed 
after a graph has been generated to allow Users to select different Points or modify the parameters of the graph 
in some other fashion.  The elements of the Trend Setup panel are explored below. 

• Historical – The Historical radio button signifies that the graph contains previously collected data.  
When selected, the Historical radio button activates the following controls: 
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o Starting Date – The beginning date for the graph.  The calendar icon to the right of the 
Date field opens a calendar window for easy date selection.  Click the desired date in the 
calendar window to enter it automatically into the corresponding Date field. 

o Starting Time – The beginning time for the graph.  Enter the desired time in the Time 
field. 

o Ending Date – The ending date for the graph.  The calendar icon to the right of the Date 
field opens a calendar window for easy date selection.  Click the desired date in the calendar 
window to enter it automatically into the corresponding Date field. 

o Ending Time – The beginning time for the graph.  Enter the desired time in the Time 
field. 

• Live – The Live radio button signifies that the graph displays real-time data as it is collected.  When 
selected, the Live radio button activates the following control: 

o Update Interval – Update Interval contains two controls: the numeric interval and the 
period unit.  Enter a numeric value into the Interval field then select the period from the 
dropdown list – Seconds, Minutes or Hours. 

• Auto Scale – This checkbox will turn on (checked, by default) or turn off (cleared) the Auto Scale 
feature for the current Trend graph.  With Auto Scale turned on, CONTROLIQ presents the entire 
range of Y values returned.  The Y values, or vertical axis, represent the data reported by a 
Component, such as temperature or static pressure.  When Auto Scale is turned off, Users can 
‘zoom in’ an area of the graph by selecting the minimum and maximum values for the Y-axis using 
the following controls: 

o Y Min – The minimum value for the Y-axis of the Trend graph.  Enter the desired 
numeric value in the Y Min field.  Only values above the desired value display on the 
graph. 

o Y Max – The maximum value for the Y-axis of the Trend graph.  Enter the desired 
numeric value in the Y Max field.  Only values below the desired value display on the 
graph. 

• Enter/Select Points – Up to ten (10) Aliases are plotted in a Trend graph.  Users may type the 
Aliases into the provided fields or click the Select Points button to pick Aliases from the Tabular 
Points list. 

• Favorite Selection – This dropdown list provides saved Trend Setup information.  Information 
saved using the Manage Favorites button allows for fast Trend graphing setup. 

• OK – The OK button begins the Trend graphing process.  Once all Trend Setup information is 
input, clicking OK will plot the graph. 

• Cancel – The Cancel button closes the Trend Setup panel without generating a Trend graph. 
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• Reset – The Reset button clears all Trend Setup information. 

S E L E C T  P O I N T S  I N  T R E N D  S E T U P  

1. Click the Select Points button 

2. The Tabular Points list displays 

3. Click in the empty checkbox in the Selection column of the desired Point, a 
check mark will appear 

4. Click in the empty checkbox of up to nine (9) more Points 

5. Click the Trend button 

6. Click the OK button to graph Trend 

 

A D D  T R E N D  S E T U P  A S  F A V O R I T E  S E L E C T I O N  

1. Arrange Trend Setup to the desired specifications 

2. Click the Manage Favorites button 

3. The Favorites Manager window opens 

4. Type a name for Trend Setup (as it will appear on Favorites dropdown list) in blank text field of the 
Favorites Manager window 

5. Click the Add button 

6. Trend Setup is now saved as a Favorite 

 

D E L E T E  T R E N D  S E T U P  F R O M  F A V O R I T E  S E L E C T I O N S  

1. Click the Manage Favorites button 

2. The Favorites Manager window opens 

3. Click on the Favorites dropdown list in the Manage Favorites window 

4. Click on the desired selection 

5. Click the Delete button 

6. The selected Trend Setup is now deleted from Favorites 
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Trend Graph 
The Trend Graph is one of two tabbed displays of the Trend Graph window.  The tab is located near the 
upper left corner of the window.  This tab is not active during Trend Setup.  Once setup is complete, the graph 
automatically loads in this display.  Clicking this tab while viewing Tabular Data will redisplay the current graph.  
Two buttons, Setup and Export, are located below the graph.  Setup displays the Trend Setup window while 
Export opens the Export window. 

The graph is plotted over two (2) axes.  The Y-axis (vertical) if for Component measurement, such as 
temperature or static pressure, while the X-axis (horizontal) measures time. 

 

Tabular Data 
The Tabular Data is one of two tabbed displays of the Trend Graph window.  The tab is located near the 
upper left corner of the window.  This tab is not active during Trend Setup.  Clicking this tab while viewing the 
Trend Graph will display the tabular data used to populate the graph.  Two buttons, Setup and Export, are 
located below the graph.  Setup displays the Trend Setup window while Export opens the Export window. 

The Tabular Data is made up of three (3) columns.  The first is the Alias name followed by the Value, such as 
temperature or static pressure.  The last column is the Date and time the value was recorded. 

 

Exporting and Printing Trends 
CONTROLIQ exports Trend data in three (3) formats: email, Comma Separated Value (CSV) file or web page 
(HTML) file.  Trend graphs can also be printed from the Trend Graph window. 

P R I N T  T R E N D  G R A P H  

1. Right-click the Trend Graph image 

2. Select Print Picture… from pop-up menu 

3. The Print window opens 

4. Select the desired Printer 

5. Configure the printer Options as needed 

6. Click the Print button 

 

E X P O R T  T O  E M A I L  

1. Click the Export button 

2. The Export window opens 
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3. The Export to Email radio button is selected automatically 

4. Enter the Email Address of recipient 

5. Enter the email Subject 

6. Click the Export button 

 

E X P O R T  T O  F I L E  

1. Click the Export button on Trend Graph window 

2. The Export window opens 

3. Click the Export to CSV File or the Export to HTML File radio button 

4. Click the Export button in Export window 

5. The File Download window opens 

6. Click the Save button in File Download window 

7. The Save As window opens 

8. Enter the File Name 

9. Select the location to save file 

10. Click the Save button in Save As window 

Administrative Reports 
Administrative reports provide information on a variety of subjects.  These reports are provided to help System 
Administrator’s get the most out of CONTROLIQ.  The following sections list each of the reports.  The 
Administrative reports share a common display window.  The Report Type dropdown list, near the upper left 
corner of the window, selects the style of Administrative report displayed.  By default, the Activities report 
displays when first opened. 

D I S P L A Y  A D M I N I S T R A T I V E  R E P O R T S  W I N D O W  

1. Click the Control Panel Tab 

2. Click on Administrative in the Reports area of the Control Panel 

3. The Administrative Reports window opens displaying the Activities Report 
Type 
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C H A N G E  A D M I N I S T R A T I V E  R E P O R T  D I S P L A Y E D   

1. In the Administrative Reports window, click the Report Type dropdown list 

2. Select the desired report 

3. The Administrative Reports window now displays the desired report 

 

Activities 
The Activities report allows Administrators to display all User related activity.  CONTROLIQ records each 
transaction and stores the information in the Database.  Report filters include Date and Time, User and 
Activity.  Administrators can also control which columns display.  Activities reports can be Exported in one of 
three (3) file formats. 

• Start Date – Starting date for report filter.  Default display current date.  The calendar icon to the 
right of the Date field opens a calendar window for easy date selection.  Click the desired date in 
the calendar window to enter it automatically into the corresponding Date field. 

• Start Time – Starting time for report filter in 24-hour format.  Default display beginning of day 
(00:00). 

• End Date – Ending date for report filter.  Default display current date.  The calendar icon to the 
right of the Date field opens a calendar window for easy date selection.  Click the desired date in 
the calendar window to enter it automatically into the corresponding Date field. 

• End Time – Starting time for report filter in 24-hour format.  Default display end of day (23:59). 

• User – Dropdown list of authorized Users for report filter. 

• Activities – Dropdown list of User Activities for report filter: 

o All – Displays all Activities performed by Users within the starting and ending date/time 
filters 

o Alarms Acknowledged – Displays only Acknowledged Alarms performed by Users 
within the starting and ending date/time filters 

o Logins/Logouts – Displays only Logins/Logouts performed by Users within the starting 
and ending date/time filters 

o Override – Displays only Overrides performed by Users within the starting and ending 
date/time filters 

o Schedule Modifications – Displays only Schedule Modifications performed by Users 
within the starting and ending date/time filters 
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o Setpoint Modifications – Displays only Setpoint Modifications performed by Users 
within the starting and ending date/time filters 

• Apply – The Apply button displays the Activities report with selected filters.  Once all Activities 
filter information is input, clicking Apply will list the transactions. 

• Columns – The activities report display five (5) columns of information.  Administrators can use 
the Columns button to choose which columns display for the report. 

o User – Name of User performing the Activity 

o IP Address – The IP Address from which the User performed the Activity 

o Alias – The name of the modified item, such as the Schedule Name or Setpoint 

o Log Date – The data and time the Activity was performed by the User 

o Log Message – What was modified by the User 

• Export – Displays the Export window 

A D D  C O L U M N S  I N  A C T I V I T I E S  R E P O R T  

1. In the Administrative Report - Activities window, click the Columns button 

2. The Column View panel displays 

3. Click in the empty checkbox of the desired Column, a check mark will appear 

4. The Column displays in the Activities report 

5. Click any remaining empty checkboxes to display hidden Columns 

6. Click the Close button in the Column View panel 

 

H I D E  C O L U M N S  I N  A C T I V I T I E S  R E P O R T  

1. In the Administrative Report - Activities window, click the Columns button 

2. The Column View panel displays 

3. Click the checkmark of the desired Column in the Column View panel, the 
check mark will clear 

4. The Column is hidden in the Activities report 

5. Click any remaining checkmarks to hide Columns 

 8-8 



R E P O R T S  C H A P T E R  8   
 

6. Click the Close button in the Column View panel 

 

G E N E R A T E  A C T I V I T I E S  R E P O R T  

1. In the Administrative Report window, select Activities from the Report Type 
dropdown list 

2. Select the Starting Date and Time 

3. Select the Ending Date and Time 

4. Select User or Activities 

5. Select the Columns displayed 

6. Click the Apply button 

7. The Activities report displays 

 

Degree Day 
The Degree Day report displays historical information regarding the unit used in estimating fuel requirements 
for heating or cooling a building.  By definition, a Degree Day is one degree of departure, on a single day, of the 
daily mean temperature from a given standard temperature.  65 degrees Fahrenheit is the standard temperature.  
Values present represent the Degree Days above (cooling days) or below (heating days) this standard 
temperature. 

• Start Date – Displays the starting date for the Degree Day date range.  This field is not editable. 

• End Date – Displays the ending date for the Degree Day date range.  This field is not editable. 

• Pick Range – Dropdown list provides various date ranges for Degree Day report: 

o Today – Displays Degree Day information for current date 

o Yesterday – Displays Degree Day information for previous day 

o Month to Date – Displays Degree Day information from beginning for current month 
through current date 

o Month – Displays Degree Day information for month selected.  CONTROLIQ Displays 
information for selected month of current year or previous year.  For example, if it is 
currently November and September is selected as the date range, data displays from current 
year.  However if current month is November and December is selected, CONTROLIQ 
displays information from the previous year. 
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• Apply – The Apply button displays the Degree Day report with selected date range.  Once the 
Degree Day date range is selected, clicking Apply will list the values. 

• Export – Displays the Export window 

• Columns – The Degree Day report displays three (3) columns: 

o Date – The date within the selected date range 

o Cool – The number of Cooling Degree Days for the Date in question 

o Heat – The number of Heating Degree Days for the Date in question 

• Cumulative Total – The total number of Heating and Cooling Degree Days for the selected date 
range 

G E N E R A T E  D E G R E E  D A Y  R E P O R T  

1. In the Administrative Report window, select Degree Day from the Report 
Type dropdown list 

2. Click the Pick Range dropdown list 

3. Select the desired date range 

4. Click the Apply button 

5. The Degree Day report displays 

 

Meters 
The Meters report displays the accumulate readings from all Meter type EMS Points.  The Meter report has the 
following elements: 

• Start Date – Displays the starting date for the Degree Day date range.  This field is not editable. 

• End Date – Displays the ending date for the Degree Day date range.  This field is not editable. 

• Pick Range – Dropdown list provides various date ranges for Meters report: 

o Today – Displays Meters information for current date 

o Yesterday – Displays Meters information for previous day 

o Month to Date – Displays Meters information from beginning for current month through 
current date 
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o Month – Displays Meters information for month selected.  CONTROLIQ Displays 
information for selected month of current year or previous year.  For example, if it is 
currently November and September is selected as the date range, data displays from current 
year.  However if current month is November and December is selected, CONTROLIQ 
displays information from the previous year. 

• Apply – The Apply button displays the Meters report with selected date range.  Once the Meters 
date range is selected, clicking Apply will list the values. 

• Alias – The name of the Meter type EMS Point (located to the far left) 

• Period – The date range of the report 

• Consumption – The total utility consumption during the date range of the report 

• Highest Demand – The highest demand of energy during the date range of the report 

• Columns – The columns of the Meter report are hidden until the plus sign (+) to the left of the 
Alias are clicked.  The Meter report displays three (3) columns: 

o When – The date/time of the Meter reading.  The detail records of this report are hourly 
increments for report range of one day and daily increments for report range of one 
month. 

o Demand – The highest demand for the record period (hour/day) 

o Consumption – The total consumption for the record period (hour/day) 

• Export – Displays the Export window 

G E N E R A T E  M E T E R S  R E P O R T  

1. In the Administrative Report window, select Meters from the Report Type 
dropdown list 

2. Click the Pick Range dropdown list 

3. Select the desired date range 

4. Click the Apply button 

5. The Meters report displays 

 

Point Finder 
The Point Finder report allows System Administrators the ability to search the Database for references to 
specific Points.  Administrators enter the Alias as a Search parameter and the report displays all matching 
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records in the Database.  This is an advanced technique used to verify and troubleshoot EMS Points.  The 
Point Finder report is made up of the following elements: 

• Alias – The text search field.  Enter search criteria in this field. 

• Search – CONTROLIQ begins seeking matching records in the Database once the Search button 
is clicked.  Text entered into the Alias field will be matched exactly. 

• Export – Displays the Export window 

• Columns – The Point Finder report displays three (3) columns: 

o Table – The table in which the matching record is located 

o Alias – The Alias, or name, of the matching record 

o Field – The field of the Database in which the match was found 

G E N E R A T E  P O I N T  F I N D E R  R E P O R T  

1. In the Administrative Report window, select Point Finder from the Report 
Type dropdown list 

2. Type the search criteria into the Alias field 

3. Click the Search button 

4. The Point Finder report displays the matching records 

 

Point Snapshot 
The Point Snapshot displays all the active Points in CONTROLIQ.  This snap shot provides a way to export 
Point information from CONTROLIQ.  The report displays eight (8) columns of information as well as the 
Export button: 

• Alias – The EMS Point Alias 

• Name – The EMS Point Name 

• Group – The Group to which the Point belongs (if any) 

• Value – The current Value of the Point (only valid at the time the report is generated) 

• Status – Current Status of Point 

• Subsystem – The Subsystem to which the Point belongs (if any) 
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• Type –  The Point Type 

• Address – Address of the Point 

• Export – Displays the Export window 

G E N E R A T E  P O I N T  S N A P S H O T  R E P O R T  

1. In the Administrative Report window, select Point Snapshot from the 
Report Type dropdown list 

2. The Point Snapshot report displays 

 

Exporting and Printing Administrative Reports 
CONTROLIQ exports Administrative reports in three (3) formats: email, Comma Separated Value (CSV) file or 
web page (HTML) file.  Administrative reports can also be printed from the Administrative Reports window. 

P R I N T  A D M I N I S T R A T I V E  R E P O R T S  

1. Right-click the Administrative report 

2. Select Print from pop-up menu 

3. The Print window opens 

4. Select the printer 

5. Configure the printer Options as needed 

6. Click the Print button 

 

E X P O R T  T O  E M A I L  

1. Click the Export button in the Administrative Reports window 

2. The Export window opens 

3. The Export to Email radio button is selected automatically 

4. Enter the Email Address of recipient 

5. Enter the email Subject 

6. Click the Export button 
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E X P O R T  T O  F I L E  

1. Click the Export button in the Administrative Reports window 

2. The Export window opens 

3. Click the Export to CSV File or the Export to HTML File radio button 

4. Click the Export button in the Export window 

5. The File Download window opens 

6. Click the Save button in the File Download window 

7. The Save As window opens 

8. Enter the File Name 

9. Select the location to save file 

10. Click the Save button in the Save As window 
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9 
Chapter 9  Schedules 
This chapter focuses on the creation and maintenance of  the Schedules that lie at the heart of  
CONTROLIQ. 

chedules grant a high level of control and automation over the entire Energy Management System.  
Schedules can be of the Standard, Exception or Holiday variety.  Scheduling is an easy-to-use interface 
for editing The start and stop of EMS Components.  This process is the crux of money-saving energy 
management. 

S 
O P E N  S C H E D U L E  W I N D O W  

1. Click the Control Panel Tab 

2. Click on Standard, Exception or Holiday in the Schedules area of the Control 
Panel 

3. The Schedule window opens 

Standard Schedules 
Standard Schedules form the foundation of building automation within CONTROLIQ.  Standard Schedules 
bring together related Components and programming logic with a timer.  The timer element of the Schedule 
determines the occupied and unoccupied states of a location.  Generally, the Schedule’s OnTime begins on or 
before a location’s expected occupancy while the OffTime represents the end of an occupied state. 

Standard Schedules represent the default settings for a building.  During ‘normal’ operations, the Standard 
Schedules hold sway.  Any deviation to these times is handled through Exception and Holiday Schedules.  The 
naming and Point selection of Standard Schedules is covered in Chapter 4 Setup. 

 

Standard Schedules Window 
The Standard Schedules window provides the primary interface for adding and editing Standard Schedules.  
There is no limit to the number of Schedules that can be created.  The Standard Schedules window is made up 
of the following elements: 
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• Filter – The Filter dropdown list provides a list of Standard Schedules.  Changing the filtered 
Schedule displays related Standard records below the dropdown list. 

• Columns – The Standard Schedules window contains the following columns: 

o Edit – The far left column displays a paper-and-pencil icon.  Clicking this icon changes the 
current row to Edit mode.  Once in Edit mode, the icon is replaced with Save (green 
checkmark) and Cancel (red ‘No’ symbol) icons. 

o OnTime – The time the Schedule is to begin (24-hour format).  In Edit mode, spin arrows 
appear to the right of the field.  Clicking these arrows add (up arrow) or remove (down 
arrow) 30 minutes to the displayed time. 

o OffTime – The time the Schedule is to end (24-hour format).  In Edit mode, spin arrows 
appear to the right of the field.  Clicking these arrows add (up arrow) or remove (down 
arrow) 30 minutes to the displayed time. 

o Weekday – Eight (8) columns represent the seven (7) days of the week plus the Holiday 
option.  Each column contains a checkbox.  Checkmarks indicate the days to which the 
Schedule will be applied. 

o Delete – The far right column contains a Delete (X) icon.  Clicking this icon deletes the 
selected record from the current Schedule. 

• Add – The Add button creates a new record for the current Schedule 

• OK – The OK button saves the current Schedule and closes the Standard Schedules window 

S E L E C T  S T A N D A R D  S C H E D U L E  

1. Click the Filter dropdown list in the Standard Schedule window 

2. Select the desired Schedule 

3. Records related to the selected Schedule display 

 

E D I T  R E C O R D  I N  S T A N D A R D  S C H E D U L E  W I N D O W  

1. Click the Edit icon (pencil-and-paper) of the desired record in the Standard 
Schedule window 

2. The row is now editable 

3. Edit the OnTime and OffTime as needed (24 hour format) 

4. Check/clear days to which the Schedule applies 
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5. Click the Save icon (green checkmark) or the Cancel icon (red ‘No’ symbol) to complete the 
transaction 

6. If Save is selected, the Save confirmation window opens 

7. Click the OK button on the confirmation window to complete the Save operation 

 

D E L E T E  R E C O R D  I N  S T A N D A R D  S C H E D U L E  W I N D O W  

1. Click the Delete icon of the desired record in the Standard Schedule window 

2. The Delete confirmation window opens 

3. Click the OK button on the confirmation window to complete the Delete 
operation 

 

A D D  R E C O R D  T O  S T A N D A R D  S C H E D U L E  W I N D O W  

1. Click the Add button in the Standard Schedule window 

2. A new editable row is displayed 

3. Enter the OnTime and OffTime (24 hour format) 

4. Check days to which the Schedule applies 

5. Click the Save icon (green checkmark) or the Cancel icon (red ‘No’ symbol) to complete 
transaction 

6. If Save is selected, the Save confirmation window opens 

7. Click the OK button on the confirmation window to complete the Save operation 

Exception Schedules 
Exception Schedules override the normal operation of Standard Schedules.  These Schedules run for a finite 
period to signify occupancy when normally the area is unoccupied.  This is most often used for meeting rooms, 
which are normally unoccupied and, therefore, do not run lights and heating/cooling to conserve energy.  The 
Exception Schedules provide a simple interface for turning on Components automatically. 
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Exception Schedules Window 
The Exception Schedules window provides the primary interface for adding and editing Exception Schedules.  
There is no limit to the number of Schedules that can be created.  The Exception Schedules window is made up 
of the following elements: 

• Filter – The Filter dropdown list provides a list of Schedules.  Changing the filtered Schedules 
displays related Exception records below the dropdown list. 

• Columns – The Exception Schedules window contains the following columns: 

o Edit – The far left column displays a paper-and-pencil icon.  Clicking this icon changes the 
current row to Edit mode.  Once in Edit mode, the icon is replaced with Save (green 
checkmark) and Cancel (red ‘No’ symbol) icons. 

o Start Date – The date the Exception Schedule is to begin.  In Edit Mode, a calendar icon 
appears to the left of the date field.  Clicking this icon opens a calendar window for easy 
date entry. 

o Days – The number of days the Exception Schedule will run 

o OnTime – The time the Schedule is to begin (24-hour format).  In Edit mode, spin arrows 
appear to the left of the field.  Clicking these arrows add (up arrow) or remove (down 
arrow) 30 minutes to the displayed time. 

o OffTime – The time the Schedule is to end (24-hour format).  In Edit mode, spin arrows 
appear to the left of the field.  Clicking these arrows add (up arrow) or remove (down 
arrow) 30 minutes to the displayed time. 

o Weekday – Eight (8) columns represent the seven (7) days of the week and the Holiday 
option.  Each column contains a checkbox.  Checkmarks indicate the days to which the 
Schedule will be applied. 

o Delete – The far right column contains a Delete (X) icon.  Clicking this icon deletes the 
selected record from the current Schedule. 

• Add – The Add button creates a new record for the current Schedule 

• OK – The OK button saves the current Schedule and closes the Exception Schedules window 

S E L E C T  E X C E P T I O N  S C H E D U L E  

1. Click the Filter dropdown list in the Exception Schedule window 

2. Select the desired Schedule 

3. Records related to the selected Schedule display 
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E D I T  R E C O R D  I N  E X C E P T I O N  S C H E D U L E  W I N D O W  

1. Click the Edit icon (pencil-and-paper) of the desired record in the Exception 
Schedule window 

2. The row is now editable 

3. Edit the OnTime and OffTime as needed (24 hour format) 

4. Check/clear days to which the Schedule applies 

5. Click the Save icon (green checkmark) or the Cancel icon (red ‘No’ symbol) to complete the 
transaction 

6. If Save is selected, the Save confirmation window opens 

7. Click the OK button on the confirmation window to complete the Save operation 

 

D E L E T E  R E C O R D  I N  E X C E P T I O N  S C H E D U L E  W I N D O W  

1. Click the Delete icon of the desired record in the Exception Schedule window 

2. The Delete confirmation window opens 

3. Click the OK button on the confirmation window to complete the Delete 
operation 

 

A D D  R E C O R D  T O  E X C E P T I O N  S C H E D U L E  W I N D O W  

1. Click the Add button in the Exception Schedule window 

2. A new editable row is displayed 

3. Enter the OnTime and OffTime (24 hour format) 

4. Check days to which the Schedule applies 

5. Click the Save icon (green checkmark) or the Cancel icon (red ‘No’ symbol) to complete the 
transaction 

6. If Save is selected, the Save confirmation window opens 

7. Click the OK button on the confirmation window to complete the Save operation 
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Holiday Schedules 
As it has been shown, both Standard and Exception Schedules contain a Holiday ‘weekday’ for operation.  The 
Holiday Schedules determine which Dates constitute a Holiday in CONTROLIQ.  Holidays act as an override 
to the normal operation of Standard Schedules.  Each Holiday contains a date and duration.  If the current day 
should fall within one of these Holidays, any Holiday scheduling is enforced rather than that of the actual day-
of-the-week.  Typically what this means is that normal operation is not applied during a holiday.  For example, 
normal operation is Monday through Friday 8 AM to 6 PM.  If Monday happens to be a Holiday, then normal 
schedules do not apply for that date. 

 

Holidays Window 
The Holidays window provides the primary interface for adding and editing Holidays.  There is no limit to the 
number of Holidays that can be created.  The Holidays window is made up of the following elements: 

• Columns – The Holiday window contains the following columns: 

o Edit – The far left column displays a paper-and-pencil icon.  Clicking this icon changes the 
current row to Edit mode.  Once in Edit mode, the icon is replaced with a Save (green 
checkmark) and Cancel (red ‘No’ symbol) icons. 

o Holiday – The name of the Holiday 

o Start Date – The date the Holiday is to begin.  In Edit Mode, a calendar icon appears 
below the date field.  Clicking this icon opens a calendar window for easy date entry. 

o Duration – The number of days the Holiday will run 

o Delete – The far right column contains a Delete (X) icon.  Clicking this icon deletes the 
selected record from the current Schedule. 

• Add – The Add button creates a new Holiday record 

• OK – The OK button saves the current Holidays and closes the Holidays window 

E D I T  R E C O R D  I N  H O L I D A Y  W I N D O W  

1. Click the Edit icon (pencil-and-paper) of desired record in the Holiday window 

2. The row is now editable 

3. Edit the Holiday name, Start Date and Duration as needed 

4. Click the Save icon (green checkmark) or the Cancel icon (red ‘No’ symbol) to complete the 
transaction 

5. If Save is selected, the Save confirmation window opens 
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6. Click the OK button on the confirmation window to complete the Save operation 

 

D E L E T E  R E C O R D  I N  H O L I D A Y  W I N D O W  

1. Click the Delete icon of the desired record in the Holiday window 

2. The Delete confirmation window opens 

3. Click the OK button on the confirmation window to complete the Delete 
operation 

 

A D D  R E C O R D  T O  H O L I D A Y  W I N D O W  

1. Click the Add button in the Holiday window 

2. A new editable row is displayed 

3. Enter the Holiday name, Start Date and Duration  

4. Click the Save icon (green checkmark) or the Cancel icon (red ‘No’ symbol) to complete the 
transaction 

5. If Save is selected, the Save confirmation window opens 

6. Click the OK button on the confirmation window to complete the Save operation 
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